Setting up the WOTgreal IDE for DNF2001

Step 1: Set up the game and create a player profile

The first thing you need to do is run the batch file that builds all of the UnrealScript files. Then
start the game and create a player profile. You can exit the game once that is done.

Step 2: Run WOTgreal and get into the IDE

When you first start WOTgreal, you’ll get a nasty error message, just click OK:

~
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WOTgreal, the editing tool for the Unreal® Engine X

Method 'GetWOTgrealSystemList' not result any value,
Source position: 3,72

e —— ——

Next, it will bring up a setup wizard, click Cancel as we’ll be configuring the IDE manually:
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r
WOTgreal Setup Wizard X

Introduction

WWelcome to the WO Tgreal Setup ‘Wizard.

Thiz wizard will guide you through the process of properly
configuring 0T greal to be used with pour game.

Y'ou can re-iun thiz wizard at any time by choosing File-
»wfizardsxWOTgreal Setup Wizard. You can also configure the
different optionz manually by going to the Options-» Preferences
TCIEEn,

< Previous 4" Finizh



At this point you will be asked whether to associate ‘uc’ files with WOTgreal, | would recommend

selecting ‘Yes’:

Information X

Do you want to associate your ".uc” files with WOTgreal?
(this can be done later from the tools menu)

Yes Mo

e ——————————————

It should confirm the association if you selected Yes, if so, simply click OK on that dialog to

confirm.

You should now be greeted by the IDE’s main user interface:
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Step 3: Configure ‘Game Information’

On the menubar, select Options->Preferences

You'll see the ‘General Information’ preferences pop up:

Preferences X
F8 General Information General Information
@ Game Information
[ Editor Browser/Explorer Info Menu/Toolbar Configuration
Auto-Backup O ey et Theme: |Defaul | [ Force %P Style Menus
Q}I Compiling & Debugaing '
& Frotected Packages (U Code Explorer Tracking Global Font: M5 Sans Seri @ Use System Font

| ﬁ Safe/Unsafe Packages

| a‘- Tools
ﬁ Source Control
[ Task List B Perform Orphan Check when WO Tareal Starts

B Usze Auto-hide Tool wWindow Animations

Check for Mew Version:  |f there is a version available newer than mine ~

B Enable Documentation Browser
B 2utornatically switch to "Code” view when changing documents

Unreal “iki Homepage: http: £ wiki. beyondunreal. comdwiki/

[ Ahwayps confim exit when WO T greal is shutting down

Dizplay Language: Englizh w

Auto Reload Extensions:

B Enable Quick Help 3¢ Cancel

Nothing needs to be changed on this screen, simply select ‘Game Information’ on the left hand
side to switch to that panel:

Preferences X

[E] General Information Game Information

AL Game Information

& Editar Current Game Type Dptions

Auto-Backup Game Type: D MF 2001 vl Edit Game Typesz  Reset To Registry Defaults

L Campiling & Debugging

= Game Executable:
%) Protected Packages e

ﬁ Safe/Unzafe Packages Fun Commandline: []Use "Extends" instead of "Expands”

; Tools

EE Source Control

Deleted Clazz Fldr: C:ADMF2001%_ToolsYwOT greal\DeletedClazzesh

[# Task List Game NI File:
e e [MOTE: this should be “just® the filename and not a fully qualified
USE[ INI File: serini filename [ie "userini not "C:iuserini])
UCC exe File:

Game Root Dir:

Source Root Dirfz):

Log Directorny:

Test Map:

tod Hame:

© Use'WOTgreal as Editor () Use Anather Program as E ditor

B Enable Quick Help 3 Cancel




On this screen:

1) Ensure ‘Game Type’ is set to ‘DNF 2001°.

2) Ensure the ‘Use “Extends” instead of “Expands” checkbox is selected.

3) Configure ‘Deleted Class Fldr:’ to point to a directory outside of your source code repository
if you’re using one. | personally have mine pointing to my temp directory.

4) For ‘Game INI File:’, browse to and select your DNF2001 System\default.ini file. It *should*
populate the other options automatically, but I’d still recommend double-checking everything.

5) For ‘User.ini file:’, you can simply leave it as ‘user.ini’

6) For ‘UCC.exe File:’, browse to and select your DNF2001 System\UCC.exe file.

7) For ‘Game Root Dir:’, browse to and select your main DNF2001 game directory, the one
containing directories like Engine, Maps, Music, Sounds, System, etc.

8) For ‘Source Root Dir(s):’, select the same directory you did for ‘Game Root Dir:’

9) For ‘Test Map:’, browse to and select any map you want the IDE to start automatically when it
launches the game from the WOTgreal IDE.

Once you’ve configured all the options, the dialog should look something like this:

Preferences X
[E] General Infarmation Game Information
AL} Game Information
& Editor Current Game Type Options
E Auto-Backup Game Type: DMF 2001 ‘ Edit Game Types  Reset To Registry Defaults

Qﬁ Compiling & Debugging
%) Protected Packages

B Safe/Unsafe Packages Run Commandline: B Use "Extends" instead of "Expands”
dF Tool
é‘; Szzrsce Contral Deleted Clazs Fldr: C:ATemp'\DeletedClazzesh
@ Taszk List Game [MI File: CADMF200145tablehSystemtdefault.ini
User INI File: user.ini [MOTE: this should be just® the filename and not a fully qualified

- filename [ie “user.ini” not "Ciuserini™])

UCC. exe File: CADMF200145tablehSystem\UCC exe

Game Root Dir: CADMF200145table’,

Source Root Dirlz): C:ADMNF200145table’

Test Map: C:ADNF200145table\mapstiz114_3.dnf @]
O UsewOTgreal as Editor () Use Anather Program as E ditor
B Enable Quick Help @ Apply 3 Cancel



Step 4: Configure ‘Editor’ options

1) In the same ‘Preferences’ window, select ‘Editor’ on the left hand side to switch to that

panel.

2) Nothing needs to be changed on the ‘Style’ tab, so select the ‘Options’ tab instead.
3) Enable the ‘Tab Key inserts tab char’ checkbox. Be very careful not to select the other
option that translates tabs to spaces as it looks similar at a glance.

The dialog should look like this:

Preferences

(] General Information

@ Game Information

Auto-Backup

Lt Compiling & Debugging
Protected Packages

@
|| B8 Safe/Unsafe Packages
| a; Tools

L?f Source Control
Task List

X
Editor
Stle  Options  Code Insight (Intellisense]  Find/Replace
Editor Behavior
B auto Indent [T 5ave Bookmarks on Exit B EBracket Completion
B Block Undo ("] Sel + Tab = Block Indent
B Bracket Highlighting [ Smart Tab [3)
(] Cursor Past EOF [ Special Characters [2)
B Cursor Past EOL [ Tabs to Spaces on Load
[CJ Enhanced Homekey B Trim ‘Whitespace on Save
[CJ HaltPage Scrall B Undo after Save
[ Highlight Line B Tab Key inserts tab char
B Huperlink Keywords B *on Modified File Tab
[ Leading Spaces to Tabs on Load [C)Z-Order File Tabs
B Enable Quick Help TIJDE'| 3 Cancel




Step 5: Configure ‘Compiling & Debugging’ options

1) In the same ‘Preferences’ window, select ‘Compiling & Debugging’ on the left hand side to

switch to that panel.

2) Nothing needs to be changed on the ‘Pre-Compile’ tab, so select the ‘Compile’ tab instead.
3) Deselect the option: ‘Include the -silent switch when compiling’

The ‘Compile’ tab’s dialog should now look like this:

Preferences

[E] General Information
@ Game Information

& Ediar
Auto-Backup

B Compiling & Debugging

{3 Protected Packages

| ﬁ Safe/Unsafe Packages
| a; Tools

Q’;T:' Source Contral

Task List

Compiling _Debugging

Pre-Compile  Compile  Post-Compile  Debugging
Options
[ &llow editing while compiling

© Use WOTgreal's built in interface to UCC for compiling
[(JUse a different thread when compiling [T Include the -silent switch when compiling
[ Automatically call "uce dumpint” for each package if the compile was successful
[ Automatically call "ucc exportcache’ for each package if the compile was successful

() Run this program/batchfile/command line to compile

Prompt for UCC Parameters

o o s Default UCC Switches
Campile [Ctrl+F9]

Compile Active [Shift+Ctl+F3)

Bath

Mewer

Usze the following constants to substitute in information about the Active File/Current Game/Current State:

Active File: $PACERGES $PACERGEDIRS $LINENUMBER% $CURRENTWORDS
$FULLFILENAMES $FILENAMES $FILENAMENOEXTS $DIRS

Current Game: $5YSTEMDIRS $GAMEINIS $USERINIS $UCCE

Syster State: $DEBUGCOMPILES $SELECTEDPACERGESS $COMPILESWITCHESS $CURRENTMODS

B Enable Quick Help

a Apply | 3 Cancel

4) Switch to the ‘Post-Compile’ tab.
5) Deselect the option: ‘Let WOTgreal parse log file and display results in Compile Results

window’




The ‘Post-Compile’ tab’s dialog should now look like this:

Preferences X

General Information Compiling Debugging

@ Game Information

& Editor

Auto-Backup

Pre-Compile  Compile  Post-Compile  Debugging
Options

ging
= B &ctivate WO Tgreal [bring it back to the front] when compiling is finished

{5 Protected Packages

i Safe/Unsafe Packages [ Let WO Tareal parse log file and display results in Compile Results window

Tools
% S ource Control Show Compiler Error/wfarning Help when available
@ Task List [T Suppress missing UCC log message

Log name if different from UCC. log:

(] Run this file after compilation is over [and was successful if you used the internal compiler)

(] Run this file after compilation is over and the compile failed [intermal compiler only)

Use the following constants to substitute in information about the Active File/Current Game/Current State:

Active File:  $PACERGES $PACEKRGEDIRS $LINENUMBERS $CURRENTWORDS
$FULLFILENAMEY $FILENAMES $FILENAMENOEXTS iDIR%
Current Game: $5YSTEMDIRS $GAMEINIS $USERINI% $UCCs

System State: $DEBUGCOMPILES $SELECTEDPACKRGESS $COMPILESWITCHESS $CURRENTMODS

B Enable Quick Help 3¢ Cancel

6) Switch to the ‘Debugging’ tab.
7) Deselect all options on this tab, the dialog should now look like this:

Preferences X

General Information Compiling _Debugging

@ Game Information
& Editar
Auto-Backup

B Compiling & Del

§y Protected Packages
B8 Safe/Unsafe Packages [ Copy MO TGREALDIR Mdinterface. dil to my game's spstem directory if the version is different
; Tools The original non W 0T greal version will be backed up to dinterface. original. dil

ﬁ Source Control Target DLL Name

[# Task List dinterface.dll Debuggerlnterface. dll Custom:

Pre-Compile  Compile  Post-Compile  Debugging
Options
[ Force IDE to top when a breakpaint is hit

[T 5end Callstack double clicks back to the game engine to be resolved

Usze the following constants to substitute in information about the Active File/Current Game/Current State:

Achive File:  $PRCERGES $PACKAGEDIRS $LINENUMBER% $CURRENTWORDS
$FULLFILENAMES $FILENAMES $FILENRMENOEXTS $DIR%
Current Game: $5YSTEMDIRS $GAMEINIS $USERINI% $UCCE

System State: $DEBUGCOMPILE: $SELECTEDPACKAGES: $COMPILESWITCHES: $CURRENTMOD:

B Enable Quick Help ¥ Cancel




Step 6: Configure ‘Protected Packages’

1) In the same ‘Preferences’ window, select ‘Protected Packages’ on the left hand side to
switch to that panel.
2) Deselect the option: ‘Enable Protected Packages’

The dialog should look like this:

Preferences X
[E] General Information Protected Packages
@ Game Information
[ Editor [ Enable Protected Packages
lg Auto-l?l_au:kup _ B Don't Allow Breakpoints in Protected Packages
Q..‘. Campiling & Debugging B Show Protected Packages in Compile List

& Frotected Packages
ﬁ Safe/Unzafe Packages

Core .&dd
$ i Editor =
ﬁ Sourcel Contral Ei?egine =
[¥] Task List i
IpDr Delete
UnrealEd
UnrealGame
'w'eb
Wehicles e
Hadmin Defaults
*Effects
HGame
wGEame_rc
Interface
#Pickups
#Pickups_rc
*weapons
Hweapons_rc
o ehddrmin

Package Mame:

B Enable Quick Help 3 Cancel

3) Now click the ‘Apply’ button to save your preferences and return to the IDE’s main window.



Step 7: Create the Package/Class tree

In the IDE’s menubar, select DNF 2001->Create Package/Class Tree:
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Quick Compile Active Document

(©) Run F9
() Run with Command... Shift+F9

@ Run Debugger
f3) Run Debugger with Command

View UCC.log
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This will build the package/class tree, populating the IDE with all the information it needs to be a
useful IDE. You should repeat this step whenever you pull new code from a repository.

You will now be able to browse the class hierarchy and use the IDE, | personally like closing the

dialogs at the bottom of the code panel as the vast majority of those features (debugging,

displaying compile results etc.) don’t work with Duke Nukem Forever 2001. Once you've closed
those windows and you’ve opened a class, it should look like any other IDE:
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Step 7: Build code reference documentation

In the IDE’s menubar, select Tools->Run UnDox:
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It will ask for an output directory, | personally have mine pointing to my Temp directory, as below:
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UnDox document Generator X

UnDax is a utility that generates HTML content for your source code files. 1tis o OK
agreat for help files, understanding the heirarchy, etc. ou can get more
information about UnD ox from http: /A, planetunreal com/undox

3 Cancel

Dutput Directory:— C:\TemphDocs'
Style Sheet

) epic O =pic? () sun

[] Don't show index. html when finished [noshow]

[]Werbose output to commandline [verbose]

Click ‘OK’ to generate the code documentation.




Once the process completes, it will pop up the generated documentation in a web browser for
you to explore:

O [ unbox x +

& = C O File | C/Temp/Docsfindexhtml

For quick access, place your favorites here on the favorites bar. Manage favorites now

All Classes dnGame

Class Freezer

source: C:\DNF2001\Stable\dnGame\Classes\Freezer.uc

U_Fragment
U_Zone1_Vegas
U_Zone2_Dam
U_Zone3_Canyon

FocalPoint -dnGame . Freezer
FocusPoint
EogMorphDispatcher
FontBaseBla
Forcefields
FractalTexture
Eragment A

FreezeDamage Freezer

Ereez: Author: Brandon Reinhart
FreezerAmmo
FreezerCollisionActor
FrozenBlock
ErozenBlockBody:
FrozenBlockLeftArm
ErozenBlockl egs
FrozenBlockRightArm
G_Banana ‘
G_Barrel

G_Barrel2

G_Barrel2_Explosive

Direct Known Subclasses:None

class Freezer
extends dnGame dnWeapon

oodnight, sweet prince.

BathFaucet
BathFaucet Broken
Book1A
Book2B
BoomBarrel
BoomBarrel2
BoomBarrelMines simulated
BoomBarrelToss
Bottle2
G_Bottle3

Destroyed()

(o] o](o] 0} o] o)) (0} 0]

void | Fire()
829 PM

N II®

It is an extremely useful resource when programming, but the IDE will also integrate the generated
documentation into its Ul making it even more useful:
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Step 8: Get your compiles working!!!
This is probably the trickiest step as it’s not actually very intuitive to get this working.

The first step is to have WOTgreal compile all packages once, otherwise you’ll probably get a
‘General protection fault!” during your first compile. To do this, select DNF 2001->Compile
Scripts (or alternatively use the button to the left of the green play button):
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The compile scripts dialog should appear, now:

1) Click the X’ checkbox to select all packages.

2) Clear the ‘Switches’ text box which got populated with the ‘-silent’ option even though we
told it not to.

The ‘Compile’ dialog should look like this now:
Compile (run ucc make) X

Choose the packages to compile :
[WOTgreal will backup the .u file from the system directory and run ucc make to create

them again)

Bl
Cannibal Engine U_Zone2_Dam
Core Fire IJ_Zone3_Canyon
dndl IpDiry |J_Zoned_AFE
dnlGame IpServer 1)_Zone5_Areasi
dnMaterial Launch 1J_Zonef_Ship
dniountables MeshEd |Browser
dnParticles Meshes 'web
driwindow U_Fragment Lindowe
DukeEd u_generic window
E ditor 1U_Zonel_Vegas wimage

Switches:

Auto-adjust Edit Packages list for fast compilation
Q}I LCompile @ Refresh Deselect All Select all 3 Cancel



3) Click ‘Compile’

4) You’ll get a dialog warning that not all the packages are part of your default.ini and it will ask
whether it should add them. To be honest, | don’t know if that’s good or bad, but for the time
being select ‘No’ if you get this dialog:

Information X

The following packages are not part of the EditPackages
list
in your default.ini file:

Cannibal, Core, DukeEd, |pDrv, Launch, MeshEd,
Meshes, Window, ximage

Do you want to add them to your EditPackages before
compiling?

Yes Mo Cancel

The compile should now start, by default, it will be in ‘simple’ mode and you won’t be able to see
what the compile is doing, click the ‘Advanced >>’ button to open up the compile details, the
dialog should now look like this, stating that the compile was successful:

WOTgreal UCC Interface

‘ Package: U_Fragment

‘ Parzing: "W'arnings: 4

‘ Compiling:  Debriz_computer0] ‘ Errors: ]

Command Line:

ucc make

Farzing Debriz_‘woodl
Compiling Debris_CinderBlock
Compiling Debris_computer0
Compiling Debriz_Glass1
Compiling Debriz_ketall
Compiling Debriz_MetalGlasz01
Compiling Debris_Stones
Compiling Debris_woodl
Success - 0 eror(z), 4 warnings
Shutting down ucc.exe

w 0K X Cancel l << Simple I




When making code changes from this point on, you can use the other option instead:
DNF 2001->Compile Active Scripts

This will automatically select the packages that you’ve changed and only compile those changes,
speeding up your turn-around time.

From here, | would recommend doing two small tests to confirm the IDE is working:

1) Test adding a deliberate compile error and make sure that when you run the compile step, it
picks up the error and gives you meaningful output.

2) Remove the compile error and make a small noticeable change to ensure that when you run
the compile step, your changes take affect in the game.

With your valid change made and successfully compiled, click the green play button to launch the
game and open your selected test map to see your change in action:

File Edit Search Browser Explorer View Options DNF2001 Debug

fools Help | GameType: DNF 2001

=d 3 & AL A =] HARE banm

@

Packages & 1 % |[Code Explorer

Play
& ) Default Properties

% Fo i

If everything worked as expected, then congratulations, you’re up and running!!!
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